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Microsoft EXCEL

An Electronic Spreadsheet Program
7

Examples of 
popular 
spreadsheet 
software’s  are    MS 
Excel,  Gnumeric, 
KSpread, ZCubes-
Calci , Lotus 
Symphony (2007) 
and Resolver One 
etc. •It displays multiple cells that together 

make up a grid consisting of rows and 
columns, each cell containing either 
alphanumeric text or numeric values.

Introduction
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What is a Spreadsheet?

A spreadsheet is a document that is 
entirely made up of rows and columns. It 
is used to list and analyze data. 

Spreadsheet programs are 
developed to automate 
tasks such as technical 
calculations, inferential 
statistics, analyzing data 
etc. 

They also have a powerful 
program for graphical 
preparation of numerical 
data. 

They are commonly used 
in Production, Planning, 
Personnel Management, 
Marketing, Payroll and 
Accounting.
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Spreadsheet Applications

Budgets: Electronic spreadsheets are commonly used to 
develop and monitor budgets.

Inventory Management : Many small businesses use 
electronic spreadsheets to keep track of inventory.

Portfolio Management : Electronic spreadsheets are used 
to keep track of investment portfolios.

Management Decision Support : Electronic spreadsheets 
are commonly used to wake projections of business 
conditions.
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Spreadsheet Features

Editing and formatting – Excel works 
much like the tables in MS Word

Creating Charts and Graphs – You 
can create colorful charts and graphs 
from the data in your worksheet. 
Excel will automatically update the 
chart to display any changes you 
make in your data. 
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Formulas and functions
– Excel allows you to 
perform calculations and 
analyze data. Common 
calculations include: 
finding the sum, average 
or total number of items in 
a list

=sum(B6:B23)

=AVERAGE(F4:F8)

=count(B2:B25)
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Spreadsheet details

worksheets

Columns

Rows

Cell 

Cell A1 
(Column A , 
Row 1) is also 
the Active 
Cell

The Ribbon
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Spreadsheet details
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Spreadsheet details
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The Office button

The Office button 
is located on the 
top-left of the 
window. Clicking 
on the Office 
button displays a 
drop down menu 
containing a 
number of 
commands. 
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The Ribbon

1. The band at the top 
of the Excel 2007 
window is the 
Ribbon. 

2. The Ribbon is made 
up of different tabs. 
Each tab is related to 
specific kinds of work 
that people do in 
Excel. 

You click the tabs at the top of the Ribbon to 
see the different commands on each tab. 
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Columns, Rows, and Cells

Worksheets are divided into columns, rows, and cells. That's the 
grid you see when you open up a workbook.  Columns go from 
top to bottom on the worksheet, vertically. Rows go from left to 
right on the worksheet, horizontally. A cell is the space where 
one column and one row meet.

 Each column has an alphabetical heading at the top. The first 26 
columns have the letters from A through Z. Each worksheet 
contains 16,384 columns in all, so after Z the letters begin again 
in pairs, AA through AZ. 

 After AZ, the letter pairs start again with columns BA through BZ, 
and so on, until all 16,384 columns have alphabetical headings, 
ending at XFD.
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Columns, Rows, and Cells

Each row also has a heading. Row headings are 
numbers, from 1 through 1,048,576. 
The alphabetical headings on the columns and 
the numerical headings on the rows tell you 
where you are in a worksheet when you click a 
cell. The headings combine to form the cell 
address, also called the cell reference.
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Cells
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Cells

Formula: A formula identifies the calculation needed to
place the result in the cell it is contained within. A cell
containing a formula therefore has two display
components; the formula itself and the resulting value.
The formula is normally only shown when the cell is
selected by "clicking" the mouse over a particular cell;
otherwise it contains the result of the calculation.
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Formula

A formula assigns values to a cell or range of cells, and typically 
has the format:

= Expression  
Example: =sum(A2..B2)

Where the expression consists of:
•values, such as 2, 9.14 or 6.67E-11; 
•references to other cells, such as, e.g., A1 for a single cell or 
B1:B3 for a range; 
•arithmetic operators, such as +, -, *, /, and others; 
•relational operators, such as >=, <, and others; and, 
•Functions, such as SUM(), AVG(), and many others. 
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Cell Reference

A cell on the same sheet is addressed as =A1

A cell on the different sheet  of the same spreadsheet is 
usually addressed as  =Sheet2!A1

A cell on the another spreadsheet  on the same 
computer or a local network could be referred as 

='C:\Documents and Settings\Username\My spreadsheets\[main 
sheet]Sheet1!A1
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Features of MS-Excel 2007

The file format used by Microsoft Excel 2007 is an 
XML-based format.

The new format provides less rigid standards for its files, 
making documents more accessible and easier to 

handle.
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Executing Commands

Excel commands can be given in one of the following 
ways:

1. Choosing an option form Office button
2. Choosing an option from the Shortcut Menu
3. Selecting a tools from the Ribbon
4. Using Shortcut key combinations
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Shortcut Menu

A shortcut menu is invoked by pressing the right mouse button
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Keyboard Shortcuts
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Keyboard Shortcuts – Formatting keys

Alt + ‘
Ctrl + Shift + ~
Ctrl + Shift + $
Ctrl + Shift + %
Ctrl + Shift + !
Ctrl + Shift + &
Ctrl + Shift + _
Ctrl + b

•Display the style dialog box
•General Num. Format
•Currency format
•Percentage format
•Comma format
•Outline border
•Remove borders
•Bold
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Keyboard Shortcuts – Formatting keys

Ctrl + i
Ctrl + u
Ctrl + 9
Ctrl + Shift + 9
Ctrl + 0
Ctrl + Shift + 0
Ctrl + 1
Ctrl + 5
Shift + Space
Ctrl + Space

•Italic
•Underline
•Hide rows
•Unhide rows
•Hide columns
•Unhide columns
•Format Dialog Box
•Strike Through
•Select the entire row
•Select the entire column
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Keyboard Shortcuts – Formatting keys

Ctrl + a
Ctrl + x/c/v
Ctrl + d/r
CTRL+SHIFT+* 

SHIFT+ arrow key
CTRL+SHIFT+ arrow key

SHIFT+HOME
CTRL+SHIFT+HOME

CTRL+SHIFT+END

•Select the entire worksheet
•Cut/copy/paste
•File cells down/right
•Select the current region around the active cell 

(the current region is an area enclosed by blank 
rows and blank columns)

•Extend the selection by one cell
•Extend the selection to the last nonblank cell in 

the same column or row as the active cell
•Extend the selection to the beginning of the row
•Extend the selection to the beginning of the 

worksheet
•Extend the selection to the last cell used on the 

worksheet (lower-right corner)
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Keyboard Shortcuts – Auditing keys

Ctrl + ‘ ( ~ )
Ctrl + [

Ctrl + Shift + {
Ctrl + ]

Ctrl + Shift + }

F9
Shift + F9
F2

•Toggle formula display
•Selects cells directly referred to by formulas 

(Precedent Cells)
•Selects directly and indirectly referred to cells
•Selects only cells with formulas that refer directly 

to the active cell (Dependent Cells)
•Selects all cells within formulas that directly or 

indirectly refer to the active cells
•Calculate all worksheets
•Calculate worksheet
•Toggle cell edit mode
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Keyboard Shortcuts – Window keys
Ctrl + F4
Alt + F4
Ctrl + F10
Ctrl + F9
Ctrl + F5
F6
Shift + F6
Ctrl + F6
Ctrl + Tab
Shift + F11
F11
Ctrl + s
F12
Ctrl + o
Ctrl + n
Alt + F8
Alt + F11

•Closes workbook window
•Closes Excel
•Maximizes the workbook
•Minimizes the workbook
•Restore window size
•Next pane
•Previous pane
•Next window
•Next window
•Inserts a new sheet
•Create a Quick Chart Sheet
•Saves the workbook
•Saves As
•Opens a workbook
•Creates a new workbook
•Macros Dialog Box
•Visual Basic Editor
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Using Sheets in Workbook

A] Rename a Worksheet

•On the Sheet tab bar, right-click the sheet tab to 
rename, and then click Rename. 

•Select the current name, and then type the new 
name. 
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Copying or Moving Worksheet

B] Copying or Moving the Worksheet
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Using Sheets in Workbook

C] Inserting additional Worksheet

1. To quickly insert a new worksheet at the 
end of the existing worksheets, click the 
Insert Worksheet tab at the bottom of 
the screen. 

2. To insert a new worksheet before an 
existing worksheet, select that 
worksheet, and then on the Home tab, 
in the Cells group, click Insert, and then 
click Insert Sheet.
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Using Sheets in Workbook

D] Deleting Worksheet

On the Home tab, in the Cells group, click the arrow next to Delete, and 
then click Delete Sheet. 
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Entering data

You can enter two basic kinds of 
data into worksheet cells: 

•numbers 
•text.
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Auto Fill
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Navigating in the Worksheet

TO MOVE PRESS KEY

Left one column Left arrow

Right one column Right arrow

Up one row Up arrow

Down one row Down arrow

To the first cell of a row Home

To cell A1 Ctrl+Home

To the last cell containing 
data

Ctrl+End

Up one window Page Up

Down one window Page Down
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Delete  Cells
Now you will see this 

dialogue box.
Choose the correct 
option. This will depend 
on where you want to 
put the new cells.
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Saving a Workbook

When we open a 
workbook in Excel, by 
default, the name of 
the workbook is called 
“Book” followed by a 
number (For example, 
“Book2”). The 
workbook will keep 
that name until you 
save the workbook
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Saving a Workbook

The first time a 
workbook is saved, 
the user must decide 
three things:

•File Location
•File Name
•File Type
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Exercise

Name Jan Feb March

Amar 310.56 403.10 384.10

James 431.72 342.00 344.00

Samuel 600.00 299.18 402.17

Lydia 456.07 466.00 610.00

Tina 201.10 342.19 334.04

In this exercise, you will be required to use
an Excel spreadsheet to answer the
following questions:

1. The table shows the quarterly
expenditure of five people in a household.

2. Load Excel application and enter the
data on a worksheet as shown ->

3. Insert another column after March and
name it "Total" and calculate the Total
Quarterly expenditure for each person in
the household.

4. Save the document under the name of
Expenditure and Print.
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Cell References

Cell references Refer to values in

A10 the cell in column A and row 10

A10,A20 cell A10 and cell A20

A10:A20 the range of cells in column A and rows 10 through 
20

B15:E15 the range of cells in row 15 and columns B through E

A10:E20 the range of cells in columns A through E and rows 
10 through 20

Cell references can indicate particular cells or cell ranges in 
columns and rows.

Cell Referencing

A reference identifies a cell or a range of cells on a worksheet and 
tells Microsoft Excel where to look for the values or data you want 
to use in a formula. 

With references, the user can use data contained in different parts 
of a worksheet in one formula or use the value from one cell in 
several formulas. 

The user can also refer to cells on other sheets in the same 
workbook, and to other workbooks. References to cells in other 
workbooks are called links.

Reference types

Relative 
references 
change as they 
are copied.

Absolute 
references stay 
the same as they 
are copied.

Relative Reference 

 Relative Every relative cell reference in a formula 
automatically changes when the formula is copied down 
a column or across a row. This is why in the first lesson 
you could copy the January formula to add up February 
expenses. As the example, when the formula =C4*$D$9 
is copied from row to row, the relative cell references 
change from C4 to C5 to C6.

Absolute Reference 

 Absolute An absolute cell reference is fixed. Absolute 
references don't change if you copy a formula from one cell 
to another. Absolute references have dollar signs ($) like this: 
$D$9. As the art shows, when the formula =C4*$D$9 is 
copied from row to row, the absolute cell reference remains 
as $D$9.

Mixed Reference

 Mixed A mixed cell reference has either an absolute 
column and a relative row, or an absolute row and a 
relative column. For example, $A1 is an absolute 
reference to column A and a relative reference to row 1. 
As a mixed reference is copied from one cell to another, 
the absolute reference stays the same but the relative 
reference changes.
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Ranges

A range is a rectangular group of cells. The smallest range 
is a single cell and the largest range includes all the cells 
in the worksheet. A range can include cells from same 
sheet or cells from adjacent sheets. Ranges are defined 
by the addresses of two opposite or diagonally paired 
corner cells separated by a colon or two dots.
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Naming Ranges

You can apply a name to refer to a cell or a range of cells, rather than 
using cell addresses as references. Names provide multiple benefits:

1. Names are more descriptive and easier to remember than cell 
addresses.

2. When a cell moves, the name moves with it.

3. You can use a name in place of a cell or range address in a formula 
or function argument, just like a row or column label.

4. When you copy a formula that uses a name, the effect is the same 
as using an absolute cell reference.
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Rules for  Range Names

1. Names can be tip to 255 characters long and can include letters, numbers, 
underscores, or periods.

2. The name must begin with either a letter or the underscore character. You 
cannot use spaces, commas, exclamation points, or other special characters.

3. Names cannot be valid cell addresses: F1998 cannot be used as a name.

4. Names are not case sensitive.
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Using Range Names in Formula

1. Start Excel.
2. Create the above worksheet:
3. Highlight the figures in the Delhi column.
4. Click in the name box at the top of the spreadsheet. The name box 

normally contains the address of the current cell.
5. Type Delhi in the name box and press Enter. The range of numbers is 

now identified by the name Delhi.
6. Click in the Totals cell for Delhi to select it.
7. Type: =SUM(Delhi)
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Using Range Names in Formula

You can also use names in formulas. For example:
=SUM(JanSales)
=TotalSales * TaxRate
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Using Range Names in Formula

Exercise:

You can assign any 
name you want as 
follows: 
Select one or more 
cells and choose 
Insert > Names > 
Define. 
Type the name, click 
Add, and click OK. 
Then you can create 
formulas like this. 
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Formulas

A formula always begins with an equal sign (=) followed 
by some combination of numbers, text, cell references, 
and operators. If a formula is entered incorrectly, an 
ERROR IN FORMULA message will appear.
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Formulas Operators

• To do more than add, use other math operators 
as you type formulas into worksheet cells. Use 
a minus sign (-) to subtract, an asterisk (*) to 
multiply, and a forward slash (/) to divide. 
Remember to always start each formula with 
an equal sign.
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Parts of a formula
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How to enter a formula

1. Click a cell where you want to enter a formula.
2. Type = (equal sign) to begin the formula.
3. Type the first argument. Remember, an argument can be 

a number or a cell reference. You can type in the number 
or if referencing a cell, you can single click on the cell 
location to have the cell reference automatically included 
in your formula.

4. Next, type an arithmetic operator.
5. Next, enter the next argument.
6. Steps 4 and 5 can be repeated as many times as needed 

to add to the formula.
7. Last, tap the ENTER key. The result of the formula appears 

in the cell while the formula itself appears in the Formula 
Bar.
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Point and Click formula

Instead of entering a formula by typing it out letter by letter, Excel lets you 
create formulas by clicking the cells you want to use. 

For example, consider this simple formula that totals the numbers in two cells:
=A1+A2

To build this formula by clicking, just follow these steps:
1. Move to the cell where you want to enter the formula. This cell's where the 
result of your formula's calculation will appear. While you can pick any cell on 
the worksheet, A3 works nicely because it's directly below the two cells you're 
adding. 
2. Press the equal sign (=) key. The equal sign tells Excel you're going to enter a 
formula. 
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Point and Click formula

3. Move to the first cell you want to use in your formula (in this case, A1).
You can move to this first cell by pressing the up arrow key twice, or by clicking it 
with the mouse. 

4. Press the + key.
Excel adds the + sign to your formula so that it now reads =A1+. 

5. Finish the formula by moving to cell A2 and pressing Enter.
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Auto Sum

To quickly add a 
column of data 
together, use the SUM 
button. To use this 
feature, select the 
numbers you want to 
add together by 
clicking and dragging, 
then click on the SUM 
symbol.  
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Sum button
click in cell B7, and then:
On the Home tab, click the 
Sum button in the Editing
group.
A color marquee 
surrounds the cells in the 
formula, and the formula 
appears in cell B7.
Press ENTER to display the 
result in cell B7.
Click in cell B7 to display 
the formula in the formula 
bar.
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Query Session

Ignite your mind to Excel


